Overview

Purpose

A database is a collection of information organized for a specific purpose. It can be paper (e.g., a file cabinet) or electronic (e.g., Excel, Access, FileMaker Pro, SAP). Consider some examples of databases you encounter everyday: the ATM machine where you access your account in your bank’s database; the scanner in the grocery store that automatically updates the inventory and customer databases every time you purchase a product. Excel is a simple database that allows you to sort, filter, consolidate and subtotal data within a single table. FileMaker Pro is a relational database that enables you to link information from multiple tables to generate useful data.

The Physics and Astronomy (P&A) database has been developed to track information not readily available; primarily graduate student and alumni information. It also contains human resources information about faculty, staff, and undergraduate physics majors. Another component of the database enables the Building Manager to manage office and lab keys throughout Bloomberg. Users can look up information in one place that they might otherwise have to pull from multiple sources.

Design

The database was designed to make data entry easier and more accurate by adding date fields and drop down boxes populated with information. To ensure consistency, there are protocols for how data will be entered in various fields. For example, the entire name of a college or university will be spelled out. Instead of entering the abbreviation UMD, you would enter University of Maryland.

An individual’s name should appear only once in the database to avoid duplication. To show multiple roles (e.g., graduate student and alumni), there are several Personnel Types from which to choose.

*Note: The database may not run optimally if an earlier version is used.
Database Security

Access to the different tabs and fields in the database will depend on your role. Different security levels have been established for the database administrators; IT Staff; limited faculty; Budget Analyst (BA) and Research Service Analyst (RSA). For example, limited faculty has been given read-only access which allows them to view information. They cannot make any edits or changes in the database.

Help

Operational Assistance (additions/updates to records):
Graduate/Undergraduate Students and Alumni: Academic Program Administrator and Academic Program Coordinator
Faculty/Staff: Human Resources Coordinator and Administrative Secretary
Keys Management: Facilities Services Coordinator

Design and Technical Questions: Mellissa Williams, Jon Schroeder and Michael Allison

Mailing list: pha-fmp@lists.johnshopkins.edu
# Table of Contents

LOGGING IN ........................................................................................................................................... 5
  FIRST TIME LOGIN ................................................................................................................................. 5
  REGULAR LOGIN .................................................................................................................................... 7

NAVIGATION ............................................................................................................................................... 8

FIND MODE ............................................................................................................................................... 9
  BASIC FIND ........................................................................................................................................... 9
  ADVANCED FIND .................................................................................................................................... 9
  SAVE CURRENT FIND ............................................................................................................................... 10

ADD A RECORD ......................................................................................................................................... 14

EDIT A RECORD ......................................................................................................................................... 15

REPORTS .................................................................................................................................................. 16
  VIEW ...................................................................................................................................................... 16
  EXPORT TO EXCEL ................................................................................................................................. 17
  CREATE PDF ............................................................................................................................................ 17
  CREATE A SIMPLE REPORT ..................................................................................................................... 18

ACTIVE LAYOUTS ....................................................................................................................................... 21
  Personnel Data Entry .............................................................................................................................. 21
  Human Resources – (Owner - Human Resources Coordinator) ............................................................... 21
  Data Integrity – (Owner - Communications Team) ................................................................................... 22
  Academic Affairs – (Owner - Academic Program Administrator) ............................................................ 22
  Facilities – (Owner - Facilities Services Coordinator) ............................................................................. 22
  Space – (Owner - Administrator) ........................................................................................................... 23
  Miscellaneous ......................................................................................................................................... 23

ACTIVE REPORTS .................................................................................................................................... 24

ACRONYMS .............................................................................................................................................. 26

GLOSSARY ................................................................................................................................................ 26

DEMOGRAPHICS TAB (IN ORDER OF APPEARANCE) ............................................................................. 26
CONTACT TAB (IN ORDER OF APPEARANCE) ............................................................................................. 31
POSITION TAB (IN ORDER OF APPEARANCE) ........................................................................................... 33
To access the Physics & Astronomy database from a computer with FileMaker Pro (FMP):

**First Time Login**

1. Open FMP.

2. File > Open Remote

3a. Add > Host's Internet Address: foster.win.ad.jhu.edu.

3b. File Settings > click radio button “show all available files for this host”

   Save > Cancel > Cancel, then close FMP.

4. Click on "PHA Demographics DB" > Open
5. Enter JHED credentials.

The Personnel Data Entry screen should appear. Tip: You may need maximize to full screen mode by clicking the Maximize/Restore button in the upper right hand corner of the window or resize the window.
Regular Login

1. Open FMP

2. Double click on the PHA Demographics DB (FOSTERS) heading and the Personnel Data Entry screen will appear.
Navigation

There are four basic views in FMPro: Browse; Find; Layout; and Preview.

**Browse** – Allows you to add, view, edit, sort, omit (hide), and delete information in a record.

**Preview** – Use this mode to see how data looks before printing.

**Find** – Allows you to search for records that match a set criteria.

**Layout** – Used to make modifications to a layout (only designated staff has the ability to make modifications).

When you first log in, you are in Browse mode. On the lower left hand corner of the window, you have sizing buttons to adjust to a smaller or larger view (the default setting is 150) and the option to switch between the four views (can also be accessed from the Toolbar under “View”).

**Exercise:** Switch between modes: Browse, Preview, Find and Layout using buttons and menu.

**Exercise:** View tabs and fields within each tab.

**Exercise:** Navigate between records using arrows and slider.

**Exercise:** Sort “All” Records by “Full Name” in “Ascending” order.
Find Mode

Basic Find

You can perform a search for summary data that matches a set criterion in the Find mode. You can easily search for summary data by selecting the field, and clicking the “Find” button.

For Example, to find all “Administrative Staff”, you would click this Personnel Type in the Demographics tab, then “Perform Find”.

To cancel the search so that all records appear, click the “Show All” button.

Tip

Exercise: Find the total number of “Faculty”.

Advanced Find

You may need to narrow your search by selecting multiple fields. Here are some examples of searches using more than one field.

Exercise: Find the total number of “Male” “Graduate Students”.

Exercise: Find the total number of “Current” “Faculty”.
Exercise: Find the total number of “Current” “Physics & Astronomy” “Faculty”.

Exercise: Find the total number of “Current” “Graduate Students” with Robert Leheny listed as their “Advisor”.

Exercise: Find the total number of “Graduate Students” who “Matriculated” in the year 2009.

Save Current Find

Saving your current find will assist in future searches and reporting requests.

To Save a Current Find:

1. Create a Find to locate the person(s) in the database you wish to view.
2. Click on the “Records” field on the top of your Tool Bar and select “Saved Finds”.
3. Then select “Save Current Find”.
4. You will be prompted to name and save the Current Find.
5. To access these finds in the future, simply select “Records”, “Saved Finds”, then name of the Saved Find you wish to utilize and the records will appear.

Complex Saved Finds – There are occasions when you may be asked to search for records that require an “Advanced/Complex Find”. To accomplish this:

1. Follow steps 1-4 in “Saving a Find” above.
2. When this is completed, select “Records”, “Saved Finds” then “Edit Saved Finds”.


3. A list of all of your Saved Finds shall appear.

4. Click on the “Saved Find” you wish to add to and select “Edit”.

5. Upon selecting “Edit” you will see a new window, see below. Then select “Advanced”. This will give you an advanced view of the Current Saved Find.

6. Select “New” at the bottom of the window.
7. Add/Change or Remove the new search criteria you wish to add to the Current Saved Find.
8. Save the Current Find. This will provide you with the additional search criteria you are looking for.
9. If you need to add additional search criteria to your Current Saved Find, follow steps 4-8 above.
Add a Record

*Please note that only designated staff below in the department has the ability to add a record.

Graduate/Undergraduate Students/Alumni: Academic Program Administrator and Academic Program Coordinator

Faculty/Staff: Human Resources Coordinator and Administrative Secretary

Before adding a new record to the Personnel list, it is important to search the database to make sure this person is not already in the database. To do a basic name search:

1. Click on the Find button at the top of the screen (Alternate: Using the Find button on the lower left hand screen).
2. Click in the Last name field, type the name and press the Enter key.
3. If there is more than one of the same last name in the database, you may have to restart the search and enter the first and last name.
4. If this person has a record, you can edit the information as needed. Otherwise, you will need to create a new record.
5. Prior to entering a new record, please ensure that you have all of the necessary information for that particular person, (i.e., Demographic, Contact, Position, etc…). Mandatory entry fields are marked with a red asterisk [*].
6. Spell out all data when entering information, e.g., Johns Hopkins University, not JHU or Johns Hopkins Univ.
7. Refer to the Glossary for a detailed description of each field in the database.

Exercise: Add a graduate student record.

1. Do a Find to make sure the student does not have an existing record.
2. Click the New Record button (alternates: Select Record from drop down menu or press CTRL + N).
3. Enter all relevant information.
Edit a Record

*Please note that only the designated staff below in the department has the ability to edit a record.

Graduate/Undergraduate Students/Alumni: Academic Program Administrator and Academic Program Coordinator

Faculty/Staff: Human Resources Coordinator and Administrative Secretary

To make changes to one or multiple fields in a person’s record:

1. Do a **Find** to locate the person’s record in the database.
2. Click on the tab (e.g., Demographics), then select the field to be changed.
3. Continue making changes to additional fields as needed.

Changes made to the record are not automatically saved. The system will generate a pop up prompt that will ask if you want to save the changes. This is to reduce errors since there is no way to undo a change once it has been saved. In the event that your program freezes, computer crashes, or you lose power momentarily (brownouts, lightning strikes, etc.), when you log back in to the program, double check the data to make sure it was not lost.

**Exercise:** Update the graduate student record to a postdoc and alumni record.

**Exercise:** Edit the contact information for a graduate student, and then enter two courses with grades within the Graduate Tab.

**Exercise:** Change all of the Matriculation dates for Graduate Students having matriculated on 9/1/14 to 9/2/14.
Reports

View

Exercise: View Report from List:

1. Do a basic “Find” for all current staff members that are labeled as graduate students in the “Personnel Type” box on the Demographics tab.
2. Open the Graduate Student Progress Report in the Layout menu. This will automatically show the records (Current & Graduate Student) you have found within your search, in BROWSE Mode. *Browse will give you a per person view.*

3. Select the Preview button to view data for Printing, Exporting to Excel or to save as a PDF.

4. Using the vertical scroll bar, scroll down to see the entire report, then scroll up (or press the Home key) to return to the top.

Tip
5. To return to the data entry screen, click the Layout menu and select “Personnel Data Entry”.

**Export to Excel**

Upon running the report, you may choose to export it to an Excel format if graphing or charting is desired.

1. Run the report desired.
2. Go to the “Save/Send Record As” under the File tab.
3. Select “Excel”.
4. Name and Save the file.

**Create PDF**

Follow the same steps as above (Save to Excel) except for step 3. Select “PDF”.
Create a Simple Report

*Please note that only the designated staff below in the department has the ability to create a report.

To create a simple report that can either be used as designed or for exporting into an Excel format:

1. Select File > Manage > Layouts

2. Select New > Layout/Report

3. Select a New Name for your Layout.
4. Select the type of Layout/Report you wish to create.
   a. Standard Form – Shows one record at a time. Fields appear on the left and the Data appears on the right. Basically a simple data entry form.
b. **Table View** – Shows a grid with the records in rows and the fields in columns. Lets you sort, re-order and re-size the columns.

c. **List View** – Sets up a simple columnar report.

d. **Report** – Sets up a report with grouped data and optional totals and subtotals. Grouping the data allows you to summarize the data by any field, such as region or month.

e. **Blank Layout** – Undefined. Create the Layout/Report in any fashion you wish.

5. Select the Individual Fields you wish to have in your new Layout/Report.

7. You are now finished and ready to view the output of your new Layout/Report.
   a. You may view the new layout/report in Browse Mode or Layout Mode.
      i. Browse Mode will let you view and edit records.
      ii. Layout Mode will allow you to change the formatting, add/remove fields, and modify the Table View Properties.
Active Layouts

The following layouts can be found under the layout pop up menu at the top of the ribbon.

Personnel Data Entry
The Personnel Data Entry form is used to enter demographics, contact, and position information for staff; faculty; researchers; visitors; and student workers. It is also used to add academic information for graduate and undergraduate students. Only designated staff has the ability to add and/or edit records in the system.

Human Resources – (Owner- Human Resources Coordinator)

- **Current Employee Contact Info**
  This layout is formatted to provide a rolodex card index view of each entries phone, email, and emergency contact information.

- **Current Departmental Personnel Report**
  This layout provides a breakdown of key statistical data by gender; citizenship; ethnicity; and field of study.

- **Personnel list by name**
  This layout is formatted to provide a rolodex card index view of each entries name; employment status; personnel type; and personnel #.

- **Name/email/phone**
  This layout provides a list of each entry in the database by name; e-mail address; cell phone; local phone; permanent email address; and payroll status.
Data Integrity – (Owner - Communications Team)

- **Current Staff Report**
  This layout provides a list format of the name, position, status, personnel type and administrative contact for staff whose employment status is categorized as “Current”.

**Academic Affairs – (Owner - Academic Program Administrator)**

- **Transcript- Classes Review**
  This layout provides a list of the coursework; semester; the year; and grades received by each student in the department.

- **Graduate Student Progress Report**
  Overview of graduate students’ academic career to include: exams; coursework; status notes; committees; teaching assignments; GRE Scores; and awards.

- **Departmental Personnel Data Form Graduate Students**
  This form captures the current demographic and contact information for each graduate student and all this information is displayed on one side of the form. The other side of the form has blank fields for updates/corrections to be made by the student.

**Facilities – (Owner - Facilities Services Coordinator)**

- **Keys – Main**
  This layout shows the keys that have been distributed to each staff member and the deposit obtain for each key.

- **Key Control Form**
  A completed Key Control Form for all staff members issued a key in the building. This layout is used by facility services to manage and control the distribution of keys.

- **Blank Key Control Form**
  A blank template of the Key Control Form.
Space – (Owner - Administrator)

- **Space Assignment**
  This layout is designed for the Research Service Analyst (RSA) to generate reports on the room assignments for their respective groups. It automatically displays all entries assigned to the administrative contact that opens up the layout. It has the following features:

  1. An “Employee Status Filter” button in the top right hand corner that allows movement between “Current” and “Former” staff.
  2. A “Show All Staff” button in the top right corner that will display all current staff in the database.
  3. A “Show Your staff” button in the top right corner to filter to the original report.

  The layout allows each RSA to note any room changes, termination dates and include comments. Edits can be made in the report and then converted to an Excel or PDF format. Or, the information can be downloaded to Excel for editing.

- **Monthly 366 Space Report**
  This layout shows all the staff that has a room or desk assignment in room 366.

Miscellaneous

- **Office Email Finder**
  This layout provides a list format for all staff members in the database to include their permanent email address; personnel type; position title; and field of study.
Active Reports

The following Reports can be found under Scripts at the top of the ribbon.

- **Supervisor Report**
  This report profiles all supervisors in the database and lists their current assigned staff to include the personnel number.

- **RSA Contact Report**
  A report that lists the current staff assigned to each person designated as an Administrative Contact.

- **PI Designation Report**
  A report that downloads directly into Excel a list of the faculty; research staff; postdocs; graduate students; undergraduate students; visitors; and contractors assigned to each Research Service Analyst.

- **MandatoryFieldsMissing**
  This report provides a listing of all current records and the mandatory fields that are missing information (*mandatory fields are marked with a red asterisk [*] in the database).*
The following Reports can be found under Scripts at the top of the ribbon.

- **Blank Key Control Form**
  A blank template of the Physics & Astronomy Key Control Form that is used by the Facilities Manager to collect information on distributing room keys.

- **Blank New Hire Form**
  A blank template of the Physics & Astronomy New Hire Form that is used by the Human Resources Manager to collect information on new hires.
Acronyms

GBO - Graduate Board Oral Examination

HBCU - Historically Black Colleges and Universities

POE - Preliminary Oral Examination

SPS - Society of Physics Students. Database will track undergraduate majors’ membership.

Glossary

Field - Category within a table. Examples may include: Last Name, First Name, Address etc.

Layout - The primary method of viewing and organizing data in FileMaker Pro.

Record - Contains information about a specific person or item.

Relational Database - A database that allows users to join or link tables to query data and generate reports.

Report - The process of retrieving and organizing data from a database. Reports help to organize and view data in groups. A report can generally be exported and printed with Excel.

Table - Contains fields or categories of information and records.

Value List - Contains predetermined data within a specific field(s).

Demographics Tab (in order of appearance)

Fields marked with Red Asterisk (*) are Mandatory/Required Entry Fields

Prefix/Suffix - Make a selection from the pull down menu.
*Last Name, *First Name, and Middle Initial Field - These fields are self-explanatory. Enter the names, with proper capitalization and no commas. If you include a middle initial put a period after the letter.

*DOB - Date of Birth. When you click in this field, a date picker calendar will pop up. Select the month/date/year of birth.

DOD - Date of Death. When you click in this field, a date picker calendar will pop up. Select the month/date/year of death.

*Age - This field should be auto-populated when the date of birth is entered.

*Gender - There is pull-down menu to choose either male or female.

*Race - A pull down list for categorization based on racial identification.

*Ethnicity - A pull down list for categorization as Hispanic or Non-Hispanic.

*Citizenship - The country where he or she is a natural citizen. Use the pull down menu to choose the country.

Nationality - The status of belonging to a particular nation whether by birth or naturalization. Input the country of origin in this field.

*SS# - Input the social security number. The format should be xxx-xx-xxxx.

TEMP SS# - A temporary social security number is usually given to an individual (typically foreign national) who does not have a valid United States social security number (SSN) at the time of initial employment. Input the temporary number in this field using the format xxx-xx-xxxx.

Follow up to obtain the official social security number. Add the official number in the “SS#” field and then delete the “Temp SS#”.

Marital Status - Indicates whether a person is married or single. Use the pull down menu to choose the appropriate status.

*Personnel Type - This box contains a selection of the different types of personnel classifications. Choose all that apply by clicking into the box next to the appropriate classification. The choices are:
- **Faculty** - The following titles should be categorized as faculty:
  - Professor
  - Associate Professor
  - Assistant Professor
  - Research Professor
  - Associate Research Professor
  - Adjunct Professor
  - Visiting Research Professor
  - Emeritus faculty

- **Research Staff** - Members of the department who are strongly involved in research activities and whose salary derives largely or exclusively from grants and contracts. The following titles should be categorized as research staff:
  - Principal Research Scientist
  - Research Scientist
  - Associate Research Scientist
  - Assistant Research Scientist
  - Visiting Scientist
  - Visiting Scholar

- **Postdoctoral Fellow** - A person conducting research after the completion of their doctoral studies (typically a Ph.D.) as part of a temporary appointment, usually in preparation for an academic faculty position.

- **Graduate Student** - A matriculated graduate student with a major in the physics program.

- **Undergraduate Student Worker** - An undergraduate student who is working in a full or part time job in the department of physics and astronomy.

- **Undergraduate Physics Major** - A matriculated undergraduate student enrolled in the physics program.

- **Visiting Student** - A student visiting from another university or research institution.

- **Alumni** - A graduate or undergraduate student that has received a degree from the physics and astronomy program.
- **Administrative Staff** - Employees who provide administrative support to the faculty, researchers, students, and contractors (i.e. Budget Analyst, Senior Research Service Analyst, Managers, Facilities; Human Resources; front desk and IT support).

- **Technical Staff** - Staff that participate in research and development (R&D) by performing scientific and technical tasks involving the application of concepts and operational methods, normally under the supervision of researchers. The following titles should be categorized as technical staff:
  
  o Staff Engineer
  o LAN Administrator II
  o LAN Administrator III
  o IT Manager
  o Engineering Manager
  o Software Engineer
  o Sr. Systems Engineer
  o Systems Engineer
  o Sr. Software Engineer
  o Sr. Programmer Analyst

- **Principal Investigator** - The lead researcher having the appropriate level of authority and responsibility to direct the project or program to be supported by a grant award.

- **Visitor** - A visiting scholar or research associate from another university who is given an appointment in the department.

- **IDG** - Staff that work in the Instrument Development Group (IDG) who provide professional engineering support to Hopkins researchers in need of custom-built instrumentation for scientific research.

- **Machine Shop** - Staff that work in the Physical Sciences Machine Shop (PSMS) who provide state of the art machining services and design expertise to researchers in the Department of Physics and Astronomy and in the Department of Chemistry, as well to the general Hopkins community.

- **Computer Center** - The computer center has been dismantled and is no longer in existence. Do not use this field.

- **Space Telescope Co-op** - Graduate students participating in the Space Telescope Science co-op program.
- **Academic Affairs** - The Academic Affairs staff supports the department by enhancing the graduate and undergraduate curriculum; academic support; and instruction.

- **Instruction** - Staff that provide support for classes that are taught in the department.

- **Other** – Use this category when none of the other personnel types are appropriate.

- **Contractor** - An individual from an outside company that has entered into a contractual agreement to complete specific tasks.

**Degree Information** - Text entry fields for providing information on educational background and degrees obtained. The following are the entry fields under “Degree Information”.

- *Highest Degree*
  - Institution
  - Year
- **Undergraduate Degree**
  - Secondary Degree
  - Institution
  - Year
  - HBCU

- **Graduate Degree I**
  - Institution
  - Year

- **Graduate Degree II**
  - Institution
  - Year

**Visa Information**

- **Type** - Indicate the type of visa granted to the new hire. There is a pull down menu with the following choices:
  - J-1
  - J-2
  - F-1
  - H1B
  - LPR
- PRV
- H-1
- O-1
- OSA

- **Start Date** - The official start date of the visa status.

- **End Date** - The official end date of the visa status.

- **Notes** - An open field to include additional information regarding the visa status.

**Notes** - An open field to include additional information that cannot be inputted in standard fields in the Demographics Tab.

**Contact Tab (in order of appearance)**

**Business Address**
- *Organization
- *Building
- Room#
- Room section
- *Address 1
- Address 2
- Address 3
- Address 4
- *City
- *State
- *Country
- *Zip - 5 digit code
- *Office Phone
- Office Fax
- *Office Email

**Important!**

Note – the following rule applies for “Business Address: Room#”: If the location is outside of Bloomberg Center then add an abbreviation for the location in the “Business Address: Room#” field and put the room number in the “Business Address: Room section” field. See example below.
Permanent Address
- Address 1
- Address 2
- Address 3
- Address 4
- City
- State
- Country
- Zip - 5 digit code
- Phone
- *Non-university Email
- *Cell Phone

Local Address
- *Address 1
- Address 2
- *City
- *State
- *Zip - 5 digit code
- Phone

Spouse/Significant Other - Type in the name of the spouse and/or significant other.

*Emergency Contact Name - Type in the name of the person that should be called in the case of an emergency. This is not always the spouse or significant other.

Relationship - The nature of the relationship with the emergency contact (i.e. wife, mother, father, etc.). Type the information into this field.

*Emergency Contact Number - Type in the phone number of the emergency contact in this field.
Notes - An open field to include additional information that cannot be inputted in standard fields in the Contact Tab.

Position Tab (in order of appearance)

*Employment Status* - Use the pull down menu to choose one of the following:
- Current - Active staff, faculty or researcher.
- Former - Terminated staff, faculty or researcher. Also used for individuals who are only considered “Alumni”.
- Friend - A faculty or researcher that does not have an appointment in Physics and Astronomy but has an affiliation with the department.

*Primary Divisions* - Use the pull down menu to choose the academic division.

*Primary Department* - Use the pull down menu to choose the department that initiated and processed the appointment or re-appointment.

Secondary Department - (Optional) If there is an appointment with a secondary department then use the pull down menu to make the appropriate choice.

*Supervisor* - Click on the “Add” button and a pop up box will become available for entry of this field. Type in the last or first name field to narrow down the search and then select the appropriate supervisor.

Note – The supervisor for all the graduate students should be the Academic Program Administrator.

*Administrative Contact* - The staff member responsible for providing administrative support and management. For faculty and researchers, this person is the Research Service Analyst. For administrative staff, this person is their supervisor. Click on the “Add” button and a pop up box will become available for entry of this field. Type into the “Last Name” or “First Name” field to narrow down the search and then select the appropriate administrative contact.

Budget Analyst - The budget analyst assigned to the Research Service Analyst. If not applicable, this entry should be left blank. This field is designed to automatically pre-populate once the Research Service Analyst information is inputted.

For changes to this field, go to the Personal Data Entry form for the Research Service Analyst or Senior Research Service Analyst and update the “Budget Analyst” field (or clicking on the red “Add” button and use the pop up box to enter the information).
This will automatically update the budget analyst field for all current staff assigned to the Research Service Analyst in the database.

**Tenured** - The permanent right given to a professor not to have his or her position terminated or be dismissed without just cause. Use the pull down menu to choose “Yes” or “No”.

**Tenure Track** – Being appointed to a position that will lead to tenure. Use the pull down menu to choose “Yes” or “No”.

**Joint Appointment** - When an appointment is held in the primary department and simultaneously with other divisions of the University and the School of Medicine. Use the pull down menu to choose “Yes” or “No”.

**Employment Date** - The employee’s official start date with the university. When you click in this field a Date Picker Calendar will pop up. Select the month/date/year.

**Termination Date** - The date the employee voluntarily or involuntarily leaves the university. When a date is entered into this field, the “Employment Status” field will automatically change to “Former”. When you click in this field, a date picker calendar will pop up. Select the month/date/year.

**External Affiliation** - For designating an association with an outside organization. Use the pull down menu and choose the organization. If the organization is not available, then contact technical assistance and request that it is added to the list.

**Field of Study** - Choose a discipline from the pull down list. The choices are:
- Astrophysics
- Astro Observational
- Astro/Particle Physics
- Chemistry
- Condensed Matter Physics
- Cosmology
- Elementary Particle Physics
- High Energy Physics
- None

**E-210** - Use the pull down list to make the appropriate selection.
**Responsible Conduct of Research** - When you click in this field a date picker calendar will pop up. Select the month/date/year when the responsible conduct of research training was completed.

**Lab Safety Training Completed** - When you click in this field, a date picker calendar will pop up. Select the month/date/year when the lab safety training was completed.

**Sexual Harassment Training Completed** - All staff are required to complete sexual harassment training. Check either “Yes” or “No”.

**Personnel #** - The personnel identification number given to a staff member who works at Johns Hopkins University (a.k.a. Pernr #).

**Position #** - Every position in the university is assigned a number that is used in Systems, Applications and Products (SAP) to identify individual positions within the university. This is an open data entry field for inputting the number.

*Position* - The official JHU title. Use the pull down screen to pick the appropriate title. If the title is not available then let the HR Manager know so she can update the list.

*Position Start Date* - The date the employee starting working in their current position. When you click in this field, a date picker calendar will pop up. Select the month/date/year.

**Position End Date** - The last day of appointment in the position before promotion into another title or termination of employment. When you click in this field, a date picker calendar will pop up. Select the month/date/year.

**Academic Base** - Number entry field for inputting the academic base salary.

**Full Time Equivalent (FTE)** - A number entry field for inputting the full-time equivalent labor distribution.

**Percentage (%)** - A number entry field for inputting the percentage of the full-time equivalent.

**Actual** - This is a calculation entry field that will show the value of the “Full Time Equivalent” field multiplied by the “Percentage (%)” field.
*Status - Choose a payroll status from the pull down menu. The choices are:
  o  Active
  o  Inactive
  o  LOA With Pay
  o  LOA Without Pay
  o  Retired
  o  Sabbatical
  o  Temporarily Inactive
  o  Terminated